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Chapter 1. Introduction

IBM® Everyplace® Client is an application for the Nokia Communicator that
supports data synchronization with WebSphere® Everyplace Access servers in a
secure environment.

Refer to the following sections to learn more about Everyplace Client:

» |[Everyplace Client 5.0 User’s Guide conventions|

+ |About Everyplace Client]

* [Related documentation|

Everyplace Client 5.0 User’s Guide conventions

Refer to this section to understand the conventions used in this book.

* Angle brackets—A word in angle brackets (for example, <Menu>) specifies that
there is a button on your device keypad labeled, Menu. To perform an action
with this button, you must press the button in angle brackets on your device
keypad.

* Hotkey combinations—To use a hotkey, you must press more than one button.
When you see two words with a plus sign (+) in between them (for example,
Ctrl +E), you must press the buttons labeled Ctrl and E at the same time to
perform the action.

About Everyplace Client

Everyplace Client requires that your organization’s technical support representative
create an Everyplace ID, password, and a synchronization profile for you on the
WebSphere Everyplace Access server. You can find more information about the
WebSphere Everyplace Access server in the Information Center.

The following is a list of components that Everyplace Client provides for the Nokia
Communicator:

E-mail and PIM function (Sync Client)
Everyplace Client for the Nokia Communicator synchronizes PIM and
E-mail data with Lotus® Domino® and Microsoft® Exchange servers.
Everyplace Client for the Nokia Communicator uses the Sync application
provided by Nokia.

Everyplace Client User Interface
Everyplace Client provides an integrated, single-user interface to
synchronization and non-synchronization applications.

Sametime® Connect
Sametime Connect enables you to have instant message chats with other
Sametime Connect users.

Database synchronization
Everyplace Client supports DB2 Everyplace as a database synchronization
engine.

Note: Refer to the documentation that came with your DB2 Everyplace
software for information on working with DB2 Everyplace.

© Copyright IBM Corp. 2004 1



Server Initiated Actions (SIA)

Server Initiated Actions enable the server to synchronize data between the
server and the Nokia Communicator. The server automatically initiates a
synchronization with your device via Short Message Service (SMS).

Device management

Device management enables you to receive software and device
configuration updates from the server.

Related documentation

2
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Refer to the following documentation to learn more about Everyplace Client:

WebSphere Everyplace Access Information Center

Nokia Communicator User’s Guide

Mobility Client User’s Guide for the Nokia Communicator
DB2 Everyplace Documentation

WebSphere Everyplace Access support page:
http:/ /www.ibm.com/software/pervasive/ws_everyplace_access/support/

Note: For a list of WebSphere Everyplace Access product documentation, open
the URL above, and click Product information and publications under the
Learn topic.



Chapter 2. Installation

This section describes the requirements that your Nokia Communicator device
must meet to install and run Everyplace Client software. This section also contains
instructions you need to install Everyplace Client on your device. Review the
requirements, and follow the installation steps to install Everyplace Client.

. Requirementsl

+ [Installing Everyplace Client on the Nokia Communicator]

Requirements

Before you install Everyplace Client, ensure that your device and server meet the
following requirements:

+ |Nokia Communicator requirements|

+ [Sametime Connect server requirements

* [Server requirements|

Nokia Communicator requirements

Ensure that your Nokia Communicator meets the following requirements before
you install Everyplace Client and synchronize with the WebSphere Everyplace
Access server:

* Before you can synchronize Everyplace Client with the WebSphere Everyplace
Access Server, you must create an Internet Access Point (IAP) on your Nokia
Communicator that provides you with network connectivity.

* If you use Secure Sockets Layer (SSL) to synchronize applications, you must
install a digital certificate. For more information about installing a digital
certificate, refer to [Optional—Installing a .der digital certificate}

Sametime Connect server requirements

Refer to[Sametime Connect server requirementd for a list of Sametime Connect
server requirements.

Server requirements

Check with your organization’s technical support representative to ensure that you
meet the following server requirements:

¢ To run Everyplace Client 5.0 on your Nokia Communicator, you must be
connected to and have access to a WebSphere Everyplace Access Server
operating version 5.0. Refer to the WebSphere Everyplace Access Server
Information Center to ensure that your server meets all of the required
pre-requisites.

* Before you can synchronize Everyplace Client with the server, your
organization’s technical support representative must create an Everyplace ID, a
password, and a device profile for you on the server.

© Copyright IBM Corp. 2004 3



Installing Everyplace Client on the Nokia Communicator

The Everyplace 9500YYYYMMDD_TIME.zip file includes Everyplace Client for
the Nokia Communicator, Sametime Connect, DB2 Everyplace database client, the
Everyplace Client User’s Guide for the Nokia Communicator, and the Everyplace
Client Read Me file. You can install these components in any order. For example,
you can install Sametime Connect before you install Everyplace Client.

Note: In Everyplace 9500YYYYMMDD_TIME.zip, YYYYMMDD_TIME represents
the time stamp when the .zip file was created.

Refer to the following steps to install Everyplace Client on your Nokia
Communicator:

1.

9.

Unzip the contents of Everyplace 9500YYYYMMDD_TIME.zip to a directory
on your PC.

Select the wea9500.sis file, and transfer it to your Nokia Communicator using
the infrared (IR) port. If you want to install Sametime Connect or the DB2
Everyplace database client, transfer sametime9500.sis and the contents of
DB2e814.zip for your language over to your Nokia Communicator.

Note: When you transfer files using the infrared port, the Nokia
Communicator places the files in your e-mail inbox. Refer to your Nokia
Communicator User’s Guide for more information about using the IR port.

Open your Messaging application by pressing the <Messaging> button, and
select your inbox.

Use the arrow buttons to select wea9500.sis, and press the button next to Open.

Press the button next to Open on the Save file panel to begin installing
Everyplace Client 5.0 on your Nokia Communicator.

Note: An installation security warning is displayed when you select Open. To
continue with the installation, press the button next to Install anyway.

On the About to install application panel, select Install to begin installing
Everyplace Client.

On the Add to desk panel, use the arrow keys to select the locations on your
Nokia Communicator where you want to install the Everyplace Client shortcut.
Press the button next to Select to set the values to Yes or No. The Everyplace
Client installer will install the Everyplace Client shortcut to all groups with the
value of Yes.

After you decide where you want to install the Everyplace Client shortcut on
the Add to desk panel, press the button next to OK.

Note: Unless you configure your My own button to launch Everyplace Client,
you will use this shortcut to launch Everyplace Client on your Nokia
Communicator. For more information about configuring the My own button,
refer to [Configuring the My own button to launch Everyplace Client,

Press the button next to OK when you see the Install complete panel.

Installing Sametime Connect

Refer to the following steps to install Sametime Connect on your Nokia
Communicator:

1.

4 IBM: Everyplace Client

Open your Messaging application by pressing the <Messaging> button, and
select your inbox.



Use the arrow buttons to select sametime9500.sis, and press the button next to
Open.

Press the button next to Open on the Save file panel to begin installing
Sametime Connect on your Nokia Communicator.

Note: An installation security warning is displayed when you select Open. To
continue with the installation, press the button next to Install anyway.

On the About to install application panel, select Install to begin installing
Sametime Connect.

On the Add to desk panel, use the arrow keys to select the locations on your
Nokia Communicator where you want to install the Sametime Connect
shortcut. Press the button next to Select to set the values to Yes or No. The
Everyplace Client installer will install the Sametime Connect shortcut to all
groups with the value of Yes.

After you decide where you want to install the Sametime Connect shortcut on
the Add to desk panel, press the button next to OK

Installing the DB2 Everyplace database client

If you want to install DB2 Everyplace and synchronize DB2 Everyplace database
applications on your Nokia Communicator, refer to the documentation that came

with your DB2 Everyplace software package for information on how to install and

configure DB2 Everyplace.

Optional—Installing a .der digital certificate

Optional—If you use Secure Sockets Layer (SSL) to synchronize applications, install
a .der digital certificate.

Note: Refer to your organization’s technical support representative to get the .der
digital certificate you need.

Refer to the following steps to install and configure the .der digital certificate on
your Nokia Communicator:

1.

After you receive the *.der file from you organization’s technical support
representative, select the *.der file and transfer it to your Nokia
Communicator using the infrared (IR) port.

Note: When you transfer the *.der file using the infrared port, the Nokia
Communicator places the file in your e-mail inbox. Refer to your Nokia
Communicator User’s Guide for more information about using the IR port.

Open your Messaging application, and select your inbox.

Use the arrow keys to select the *.der file, and press the button next to Open.

Press the button next to Save and save the file to a location on your device.
Press the button next to Exit after you have saved the file.

From the desktop, open the Control Panel on your device and select
Security->Certificate Manager.

Select the Other tab.

Press the button next to Add, and use the arrow keys to browse to the .der
certificate file.

Select the Other tab.
Use the arrow keys to scroll down and select the .der certificate you added.

Press the button next to View Details.

Chapter 2. Installation
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11.
12.
13.
14.

Press the button next to Trust Settings.
Set the Internet parameter to Yes.
Press the button next to Done and select Close->Close.

Press the button next to Exit to go back to the device desktop.



Chapter 3. Getting Started with Everyplace Client

After you install Everyplace Client, configure the client to connect to the
appropriate server. Contact your organization’s technical support representative for
the information you need to configure the client to connect to the WebSphere
Everyplace Access Server. For example, you will need the server address for the
WebSphere Everyplace Access Server.

Refer to the following sections to learn more about Everyplace Client:

* |Creating a synchronization profile|

* [Launching Everyplace Clien

. ‘Configuring the My own button to launch Everyplace Clien

+ |Configuring a network profile|

+ |Using the Everyplace Client user interface|

+ |Closing Everyplace Client|

Creating a synchronization profile

You must first create a device synchronization profile on the Everyplace
Synchronization Server before you can synchronize applications on your device.
You can create and base this profile on the default synchronization profile, or you
can use a profile your organization’s technical support representative creates for
you.

Note: For information on setting up the device synchronization profile on the
server, refer to the Everyplace Synchronization Server Information Center and
select the following topic: Everyplace Synchronization Server -> Configuring ->
Creating device profiles.

When you set up the device synchronization profile, use the following e-mail filter
settings for the Nokia Communicator:

 Attachments - Include none
Note: Everyplace Client does not support attachments.
You can also configure the device synchronization profile options for server or for

device data precedence in the case of a data conflict. To configure this option, refer
to the Everyplace Synchronization Server Information Center.

Launching Everyplace Client

To launch Everyplace Client, select the Everyplace Client shortcut you created
when you installed Everyplace Client and press the button next to Open.

Note: If you have configured the My own button to launch Everyplace Client,
press <My own> to open Everyplace Client. For instructions on configuring the
My own button to launch Everyplace Client, refer to Configuring the My own
button to launch Everyplace Client below.

After you launch Everyplace Client, Everyplace Client looks for your network
profile information. If Everyplace Client does not find your network profile

© Copyright IBM Corp. 2004 7



information, the Network profile screen is displayed. You must configure a
network profile before you can use Everyplace Client. Refer to

for more information about configuring a network profile.

If Everyplace Client finds your network profile information, Everyplace Client
opens to the main view panel.

Configuring the My own button to launch Everyplace Client

You can configure the My own button on the Nokia Communicator keypad to
launch Everyplace Client.

Refer to the following steps to configure the My own button on the Nokia keypad
to launch Everyplace Client:

Note: If you have already configured the My own button to launch another
application, performing the steps below will remove the association with that
application.

1. Press and hold <Ctrl> + <My own>.

2. When you see the Select application panel, use the arrow keys to select
Everyplace Client.

3. Press the button next to Done.

After you configure the My own button, you can launch Everyplace Client by
pressing the My own button.

Configuring a network profile

Before you can synchronize Everyplace Client with the server, you must create a
network profile. A network profile enables you to specify which servers you want
your device to connect to.

Refer to the following procedure to access the network profile:
1. Launch Everyplace Client.

Note: If this is the first time you have launched Everyplace Client and your
organization’s technical support representative has not configured a network
profile for you, Everyplace Client opens the Network profile dialog box.

2. Press <Menu>, select Tools -> Network profile, and press the button next to
Select. The Network profile dialog box is displayed.

3. Configure the following options according to the settings your system
organization’s technical support representative provided to you:

Everyplace ID
Enter your Everyplace ID.

Password
Enter your Everyplace password.

Note: You will need to enter your password twice for confirmation.

Internet Access Point (IAP)
To select an IAP, press <Change> and select an IAP that you have
previously configured for network connectivity. For more information
about creating and configuring an IAD, refer to your Nokia
Communicator User’s Guide.

8 1BM: Everyplace Client



Everyplace Sync Server URL
Contact your organization’s technical support representative for the
Everyplace Synchronization Server URL. Replace your.server.com with
the server host name you receive from your organization’s technical
support representative.

Online Home URL
This field is reserved for future use.

Note: If you delete any of the above settings, Everyplace Client permanently
removes the settings from your device, and you will have to re-enter them to
re-establish your connection.

4. When you are finished, select OK to save your changes and close the Network
profile dialog box.

Using the Everyplace Client user interface

Everyplace Client uses a similar user interface as other applications you will see on
your Nokia Communicator. To access menus within Everyplace Client, press
<Menu> on the keypad and use the arrow keys to navigate to the option you
want.

Closing Everyplace Client

Select Close, or use the hotkey to exit the application. To use the hot key to close
Everyplace Client, press Ctrl + E at the same time.

Chapter 3. Getting Started with Everyplace Client 9
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Chapter 4. Using Everyplace Client

This section discusses the following:

* |Using hotkeysl

+ |Opening and closing Everyplace Client applications

¢ [Using mail

* |Synchronizing datal

» |Working with device management]

Using hotkeys

You can access menu options on Everyplace Client by using hotkey shortcuts on
your Nokia Communicator.

Use a hotkey shortcut to access a specific menu item. The following table lists the
hotkey shortcuts that you have available through Everyplace Client and describes
their actions:
File menu

¢ <Ctrl> + O - Opens the application you select.

¢ <Ctrl> + R - Synchronizes the application you specify.

* <Shift> + <Ctrl> + R - Synchronizes all applications.

¢ <Ctrl> + E - Exits Everyplace Client.

Tools menu
<Ctrl> + L - Enables you to view the Everyplace Client log file.

Opening and closing Everyplace Client applications

You can open the following applications from the Everyplace Client desktop:
* Malil

* Calendar - Tasks and to do lists are included in the calendar application.

* Contacts

* Sametime Connect

* Software update

To open an application, select the application on the desktop using the arrow keys,
and press the button next to Open on the right side of the device.

Synchronizing data

Everyplace Client uses the Sync application to synchronize data on your device
with the data on the server. You do not need to configure the Sync application
because Everyplace Client creates a synchronization profile during your initial
synchronization.

You can synchronize all applications at one time, synchronize one application at a
time, or you can configure a scheduled synchronization. When you perform a
synchronization, Everyplace Client synchronizes the data on your Nokia
Communicator with the data on the server for the application you choose. You can

© Copyright IBM Corp. 2004 11
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synchronize the following items using Everyplace Client: e-mail messages, contact
information, and calendar appointments, including to do items.

Refer to the following topics for more information on synchronizing data:

Synchronizing all applications|

Synchronizing a single application|

+ |Configuring a scheduled synchronization|

Synchronizing all applications
Refer to the following procedure to synchronize all applications:

1.

From the main panel, press the button next to Sync All.

Everyplace Client displays one progress indicator for each application during
data synchronization.

When synchronization is complete, Everyplace Client displays a status message
that identifies the number of sent and received items. The message enables you
to see the number of applications that Everyplace Client synchronized
successfully and how many applications failed to synchronize.

The date next to the application status represents the date you last performed a
synchronization for that application.

Note: For a more detailed description about the synchronization, refer to the
synchronization log. To open the log after synchronization completes, press the
button next to View Log.

If you encounter a synchronization operation error, Everyplace Client displays a
status message to let you know that the operation failed.Do one of the
following:

a. Press the button next to OK to close the error message.

Note: Any applications that encountered an error during synchronization
will display an error icon next to its status indicator.

b. To attempt to synchronize again, press the button next to Retry.

c. To view the error log for more information on why the synchronization
failed, press the button next to View Log.

d. To verify that you have configured your network profile settings correctly,
press the button next to Network Profile.

Synchronizing a single application
Refer to the following procedure to synchronize a single application:

1.

IBM: Everyplace Client

Use the arrow keys to highlight the application you want to synchronize, and
press the button next to Sync.

Everyplace Client displays a progress indicator for the application during data
synchronization.

When synchronization is complete, Everyplace Client displays a status message
that identifies the number of sent and received items. The message enables you
to see if Everyplace Client synchronized successfully or if synchronization
failed.

The date next to the application status represents the date you last performed a
synchronization for that application.



Note: For a more detailed description about the synchronization, refer to the
synchronization log. To open the log after synchronization completes, press the
button next to View Log.

2. If you encounter a synchronization operation error, Everyplace Client displays a
status message to let you know that the operation failed.Do one of the
following:

a. Press the button next to OK to close the error message.

Note: Any applications that encountered an error during synchronization
will display an error icon next to its status indicator.

b. To attempt to synchronize again, press the button next to Retry.

c. To view the error log for more information on why the synchronization
failed, press the button next to View Log.

d. To verify that you have configured your network profile settings correctly,
press the button next to Network Profile.

Configuring a scheduled synchronization

Use a scheduled synchronization to have your device automatically synchronize
data from your server to your device at a time of your choosing.

Note: If you configure Everyplace Client to use scheduled synchronization, you
might be prompted for network connectivity on a regular basis.

To configure a scheduled synchronization:
1. Press the <Menu> button.
2. Use the arrow keys to select Tools.

3. Use the arrow keys to select Schedule sync from the Tools menu, and press the
button next to Select.

4. Use the arrow keys to select Scheduled sync for Sync mode.

5. For the Every field, select the time interval you want to use to synchronize
your applications. For example, If you choose 10 min, your device will
synchronize every 10 minutes.

6. Use the arrow keys to select the applications you want to synchronize. Select
Yes if you want to synchronize this application using a scheduled
synchronization, or select No if you do not want the scheduled synchronization
to include the application.

7. Press the button next to Done when you have finished configuring your
scheduled synchronization.

Note: If you do not want to use a scheduled synchronization, use the arrow
keys to select Manual sync for Sync mode.

Using mail

Using Everyplace Client Mail, you can send and receive e-mail messages by
synchronizing with WebSphere Everyplace Access Server. After you have
synchronized your e-mail application for the first time, Everyplace Client creates a
mail folder called Everyplace on your device. The Everyplace Client mail
application only supports inbox and outbox folders in the remote mail folder.

Note: Everyplace Client Mail does not support attachments.

Chapter 4. Using Everyplace Client 13



To access Everyplace Client mail:

1. Use the arrow keys to select Messaging from the Everyplace Client desktop,
and press the button next to Open. The Messaging dialog box is displayed.

2. Use the arrow keys to select the Everyplace folder, and press the button next to
Open Folder.

To write a message:

To write an e-mail that you want to synchronize with your mail server, use the
arrow keys to select Write message and arrow down to select Remote mail.
Everyplace Client places all mail that you write in the Everyplace folder outbox
until you synchronize your e-mail application with the server.

Working with device management

14

Refer to this section for more information about the following topics:

+ |Creating a device on the Device Management Server (DMS)|

+ |Creating a device configuration job|

+ |Working with software update|

Note: Device Management for the Nokia Communicator uses the device manager
application provided by Nokia.

Creating a device on the Device Management Server (DMS)

Your organization’s technical support representative must create a device on the
server for you. Contact your organization’s technical support representative for
more information.

Creating a device configuration job

Your organization’s technical support representative must create a device
configuration job for you. Contact your organization’s technical support
representative for more information. If your organization’s technical support
representative has already created a device configuration job for you, refer to
|Working with software update| to synchronize the device configuration job to your
device.

Working with software update

Refer to the following for more information about working with software updates:

* |Configuring your device for software updates|

Performing a software update on your devicel

Configuring your device for software updates

You must configure software update before you can perform a software update on
your device. Refer to the following information to configure software update on
your device:

1. Open Everyplace Client on your device.

2. Use the arrow keys to scroll to Software update, and press the button next to
Open.

3. Press the <Menu> button on your device, and select New from the File menu.

4. Press the button next to Cancel, when you see the following question:
Do you want to copy data from selected profile?

IBM: Everyplace Client



5. On the Profile settings panel, complete the information on the following tabs:

* Server: Contact your organization’s technical support representative to

complete the information on this tab.

Connection:

a) Select the Connection type and the Access point you use to access your
network.

b) For Host address, enter your DMS server address. For example,

http:/ /your.dms.server.com/dmserver /SyncMLDMServlet

Note: You must append /dmserver/SyncMLDMServlet to the end of your
host address name exactly as the example above demonstrates.
c) Enter the port number you use to connect to your network.

User: Contact your organization’s technical support representative to
complete the information on this tab.

6. Press the button next to Done to complete your profile.

Performing a software update on your device
Refer to the following steps to synchronize a device configuration job to your
device:

1.

Open Everyplace Client, use the arrow keys to navigate to Software update,
and press the button next to Open.

On the Device manager panel, press the button next to Connect.

Note: After you press the button next to Connect, the device manager
synchronizes with the server and retrieves the new device configuration job.

Chapter 4. Using Everyplace Client
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Chapter 5. Sametime Connect

Sametime Connect allows you to maintain a list of your online friends and
co-workers, enabling you to locate and securely communicate with them in
realtime. Sametime Connect enables you to create a people list. The list you create
can contain groups defined in a public address book or personal groups that you
define. When you are logged into Sametime Connect, you are notified when a
person in your list logs on to the network, allowing you to send them instant
messages.

Refer to the following topics for more information about Sametime Connect:

* |Sametime Connect server requirements|

* |Sametime Connect terms

+ |[Logging on to Sametime Connect|

+ [Working with the Sametime Connect menul

* |Sending a message to another Sametime Connect user|

+ [Managing people or groups|

+ |Changing your online status|

+ [Modifying your Sametime Connect settings|

+ |Closing Sametime Connect|

* [Sametime Connect hints and tips|

Sametime Connect server requirements

The following server and extensions are required to run Sametime Connect with
Everyplace Client:

¢ Sametime Server 3.0 or 3.1
¢ Sametime Server Extensions for Mobile Access

Note: Existing Sametime Connect customers can download the Sametime Server
Extensions for Mobile Access from the Passport Advantage® web site.

Sametime Connect terms

Refer to the following list of Sametime Connect terms for more information about
Sametime Connect:

Message
A text message exchanged between two Sametime Connect users.

Groups

Sametime Connect enables you to organize a group of your contacts under

a single group name. For example, you can create a group called Work and

group all of your work contacts under your work group. There are two

basic kinds of groups:

* Public—Public groups are groups defined by a company’s public
address book. The owner of the public address book controls and
defines membership of the public group.

* Personal—Personal groups are groups of people that you define. You can
add individuals to or remove individuals from your personal groups.

© Copyright IBM Corp. 2004 17



Online Status

Online status refers to the active status of a Sametime Connect user on the
Sametime Connect server. Sametime Connect enables you to choose one of
the following status options or create your own custom status message:

Note: You can create and leave a custom away message. For more
information on creating a custom away message, refer to
|current online status messagel.

* Offline—Sametime Connect user is not logged on and is unavailable for
chat.

¢ Active—Sametime Connect user is logged on and is available for chat.

* Away from the computer—Sametime Connect user is logged on, but
they are currently away from their computer.

* Do not disturb me—Sametime Connect user is logged on, but they do
not wish to be disturbed.

Logging on to Sametime Connect

After you launch Sametime Connect, the login panel is displayed.

Refer to the following steps to log on to Sametime Connect:

1.
2.

Enter your user name and password.

Optional—If you want Sametime to remember your password, use the arrow
keys to select Yes for the Remember password field.

Note: This option will save your password on your device. You will not be
prompted to enter your Sametime Connect password on startup.

Optional—If you want to automatically log on to Sametime Connect when you
start the application, use the arrow keys to select Yes for the Auto Log On
field.

Modifying connectivity settings

To modify your connectivity settings:

1.
2.

Press the button next to Connectivity on the log on panel.

Server Information tab:

a. In the Sametime server field, enter the name of your Sametime Connect
server.

b. In the Port field, enter the port number you want to use for Sametime
Connect.

IAP selection tab:
Choose the Internet Access Point (IAP) you want to use to connect to your
network.

Press the button next to Done to exit and save your changes, or press the
<Esc> button to exit without saving your changes.

Working with the Sametime Connect menu
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Refer to the information in this section for more information about the options
available in the Sametime Connect menu.

Note: To open the Sametime Connect menu, press the <Menu> button on your
device when you are logged on to Sametime Connect.
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File menu

 Chat - Enables you to open a chat session with another Sametime
Connect user.

Note: You must select an active user from your people list before you
select <Menu> -> Chat.

* Cycle chats - Enables you to select an active chat session.

* Close chat - Enables you to close the active chat window.

¢ Save chat - Enables you to save a chat session on your device.
* Log on - Enables you to reconnect to Sametime Connect.

* Log off - Enables you to log off of Sametime Connect.

Edit menu
¢ Cut - Enables you to cut text from a chat window.
* Copy - Enables you to copy text from a chat window.
* Paste - Enables you to paste text into a chat window.

* Select all - Enables you to select all text in a chat window.

View menu

* Manage chats - Enables you to open the Manage chats window. For
more information on managing chats, refer to [Managing chatdl

* Show online only - Specifies that you only want to see the Sametime
Connect users in your people list that are currently online.

* Hide group names - Enables you to hide all personal and public group
names.

Status menu
Enables you to select a status message. For more information on status
messages, refer to [Changing your online status|

Tools menu
* People:
— Add person - Enables you to add a new user to your people list.
— Remove person - Enables you to remove a user from your people list.

— Edit nickname - Enables you to edit the nickname of a user in your
people list. For more information on editing a nickname, refer to
[Editing a user nickname.|

* Search - Enables you to search for users.

¢ Connectivity - Enables you to modify your connectivity settings. For
more information, refer to [Modifying connectivity settings|

¢ Settings - Enables you to modify your Sametime Connect settings. For
more information on modifying Sametime Connect settings, refer to
[Modifying your Sametime Connect settings|

* View log - Enables you to view the Sametime Connect log.

Help menu
Enables you to view the About Sametime Connect information.

Sending a message to another Sametime Connect user

To send a message to another user:
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1. Use the arrow keys to select a name in your people list that you want to send a
message to.

2. Press the button next to Chat.
3. Type your message in the text area.
4. Press the button next to Send.

Managing chats

The Manage chats feature enables you to view your active chat sessions and
navigate between chat windows.

Note: You can have multiple chat sessions active at one time, but you can only
view one chat window at a time.

To manage chats:

1. Press the button next to Manage chats.

Note: If you have a chat window open, press the button next to People list,
and then press the button next to Manage chats to open the Manage chats
panel.

2. Use the arrow keys to select which active chat session you want to open, and
press the button next to Continue chat.

Managing people or groups
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Your people list contains the list of people who you want to maintain contact with,
who you want to receive messages from and who you want to send messages to.
You can add and remove Sametime Connect users to your people list, but you
must assign each person in your list to a group. When you add a Sametime
Connect user to your people list, you must select or create a personal group for
that user.

Note: The removal of a personal group is not supported.
You can also use a public group from your company’s public address book.

Note: The owner of the public group defines membership in the public address
book. You cannot add or remove public group members.

For more information, refer to the following topics:

* |Adding a Sametime Connect user]|

+ |Removing a Sametime Connect user]

» |[Editing a user nickname|

Adding a Sametime Connect user

Refer to the following steps to add a Sametime Connect user to your people list:
1. Press the <Menu> button, and use the arrow keys to scroll to Tools.

2. Use the arrow buttons to select People, select Add person and press the button
next to Select.

3. For User Name, enter the name of the contact you want to add to your people
list, or enter their complete e-mail address. If you do not know the full name of
the person you want to enter, you can search for a Sametime Connect user
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using a wildcard. For more information about using a wildcard, refer to
[Searching for Sametime Connect users using a wildcard|

Note: There will be a short delay after you press the button next to Done
while Sametime Connect searches for names matching the letters you enter.
Sametime Connect will then provide you with a list of people you can choose
to add to your people list. If Sametime Connect finds more than 10 matches,
you will be presented with a dialog box asking you to enter more information
to refine your search.

4. Optional—Enter a nickname for the person. This name will appear instead of
the user name in your people list only.

5. Assign the new contact to a group by selecting an existing personal group
name. To create a new group, type the name of the new personal group.

6. Press the button next to Done to add this person to your list.

Note: If the person is already in the group you specify, Sametime Connect will
add the user again but your people list will remain unchanged. If the person is
within another group in your people list, Sametime Connect will not add them
again. You cannot have the same user in multiple groups.

Searching for Sametime Connect users using a wildcard

If you do not know the full name of the person you want to add to your people
list, you can enter the beginning letters of their name in the User name field in
conjunction with a wildcard asterisk. For example, if you want to search for all
Sametime Connect users with the name Smith, you can enter Smi* in the User
name field. After you press the button next to Done, Sametime Connect will search
for all users with the name Smith.

Note: Your Sametime Connect messaging server must be configured to use
wildcards. For more information about your Sametime Connect messaging server
using wildcard asterisks, contact your organization’s technical support
representative.

If you choose to search for a Sametime Connect user using a wildcard asterisk,
there will be a short delay after you press the button next to Done while Sametime
Connect searches for names matching the letters you enter. Sametime Connect will
then provide you with a list of people you can choose to add to your people list. If
Sametime Connect finds more than 10 matches, you will be presented with a
dialog box asking you to enter more information to refine your search.

Removing a Sametime Connect user

Refer to the following steps to remove a Sametime Connect user from your people
list:

1. Select the person you want to remove.
2. Press the <Menu> button, and use the arrow keys to scroll to Tools.

3. Use the arrow buttons to select People, select Remove person and press the
button next to Select.

4. Press the button next to OK to remove the person, or press the button next to
Cancel to leave the person in your list.

Editing a user nickname.

Edit the nickname of a user if you want to change the display name of the user in
your people list.
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Note: Nicknames are only visible to you.

To edit a nickname:

1.
2.

3.

Use the arrow keys to select a user in your people list that you want to modify.

Press the <Menu> button, use the arrow keys to select Tools, use the arrow
keys to select People, and use the arrow keys to select Edit nickname.

Type in the new nickname, and press the button next to Done.

Changing your online status

Change your online status to notify other Sametime Connect users in your people
list that you are active, away, or do not want to be disturbed. You can define your
status messages on the Edit status messages panel.

To change your online status:

1.
2.

3.

Press the <Menu> button, and use the arrow keys to scroll to Status.

Use the arrow keys to select an online status by choosing one of the following
options:

* I Am Active

* I Am Away

* Do Not Disturb Me

 Edit status messages

Note: Editing your online status message enables you to create and display a
custom online status message. You can create and save 4 custom messages
for each of the status messages above. For example, you can create and save
4 different messages for your I Am Active message.

After you select the message you want, press the button next to Select.

Editing your current online status message

Refer to the following steps to edit your online status message or create a new
status message:

1.
2.

Press the <Menu> button, and use the arrow keys to scroll to Status.

Use the arrow keys to select Edit status messages, and press the button next to
Select.

Use the arrow keys to select the message you want to edit, and type in your
new message.

When your new message is complete, press the button next to Done.

Modifying your Sametime Connect settings
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Refer to the following for more information about modifying your Sametime
Connect settings.

Start up tab

IBM: Everyplace Client

e Start up status - Enables you to select a status you want Sametime
Connect to display on start up. Use the arrow keys to select your status.

* Auto expand all groups - Enables you to specify if you want Sametime
Connect to automatically expand or collapse all user groups. Use the
arrow keys to set the value to Yes if you want to see your user groups
expanded, or set the value to No if you want to see your groups
collapsed.



Chat tab
Time stamp on - Enables you to turn time stamps on or off. Use the arrow
keys to set the value to Yes if you want to view time stamps in your chat
windows, or set the value to No if you do not want to see time stamps in
your chat window.

Alerts tab
* Message preview when Sametime is in foreground:

— Incoming chats - Enables you to see a message preview when another
user initiates a chat session with you while Sametime Connect is
active in the foreground. Use the arrow keys to set this value to On if
you want to receive message previews, or set this value to Off if you
do not want to receive message previews.

— Incoming responses - Enables you to see a message preview of a new
chat response while Sametime Connect is active in the foreground.
Use the arrow keys to set this value to On if you want to receive new
response previews, or set this value to Off if you do not want to
receive new response previews.

* Message preview when Sametime is in background:

— Incoming chats - Enables you to see a message preview when another
user initiates a chat session with you while Sametime Connect is
active in the background. Use the arrow keys to set this value to On
if you want to receive message previews, or set this value to Off if
you do not want to receive message previews.

— Incoming responses -Enables you to see a message preview of a new
chat response while Sametime Connect is active in the background.
Use the arrow keys to set this value to On if you want to receive new
response previews, or set this value to Off if you do not want to
receive new response previews.

Note: If another Sametime Connect user sends you a message while you
have a chat window open, you will see a green icon with a white
exclamation point appear at the top of your active chat window. Use the
Manage chats feature to open the new chat window. For more information
on using managed chats, refer to [Managing chats}

Closing Sametime Connect

Select Exit, or use the hotkey to exit the application. To use the hotkey, press Ctrl +
E at the same time.

Note: You can also log off of Sametime Connect from the File menu on the menu
bar. To open the menu bar, press the <Menu> button on your device.

Sametime Connect hints and tips

Refer to this section for tips and hints that will help you use Sametime Connect
more efficiently.

+ [Navigating Sametime Connect framesg|

* |Using the search feature

. ‘Working with e-mail hot links in Sametime Connect]
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Navigating Sametime Connect frames

You can use the <Ctrl> button in conjunction the arrow keys to navigate to
different frames within Sametime Connect.

To use this function, press and hold <Ctrl> + an arrow key to move between the
chat input box, your people list, and the chat transcript.

Using the search feature

The search function enables you to search for Sametime Connect users in your
personal groups.

Refer to the steps below to search for people you have assigned to your people list:

1.

While your people list is open, press the button next to Search. The search box
is displayed at the bottom of your people list.

Note: You can use the hot key <Ctrl> + F to open the search window in the
bottom of your people list. The search window will also open if your people
list frame is active and you type on the communicator keypad. Refer to
[Navigating Sametime Connect frameq to learn more about navigating between
frames in Sametime Connect.

Type the first letter of the name of the person you want to search for, and
Sametime Connect displays a list of people in your people list that begin with
that letter. For example, if you type the letter A, Sametime Connect displays all
people in your people list whose name begins with the letter A.

Working with e-mail hot links in Sametime Connect

E-mail hot links do not use Everyplace remote mail. Use the copy and paste
function to copy the e-mail address you want to send mail to over to the
Everyplace remote mail e-mail field.

IBM: Everyplace Client



Chapter 6. Troubleshooting

Refer to the information in this section to troubleshoot Everyplace Client.

+ [Everyplace Client error messages|

* |Creating new contacts|

* [Managing time zones

» |Working with calendar invitations|

* [Synchronizing Everyplace Client to a SSL server using Mobility Client

Everyplace Client error messages

Refer to the following list of error messages, their causes, and suggested user
actions.

Not enough memory to run application.

Cause: Everyplace Client user has too many applications currently
running.

User action: Terminate some of the active applications to allocate more
memory to Everyplace Client.

Unable to retrieve e-mail information from mail folder Everyplace.
Cause: Everyplace mail folder does not exist.

User action: Synchronize your e-mail within Everyplace Client to create the
Everyplace mail folder.

SyncML: User ID not found.
Cause: A valid Everyplace user ID was not found.

User action: Verify that the information in your network profile is correct.
If you receive this error message after you have verified that the
information in in your network profile is correct, reinstall and reconfigure
Everyplace Client.

SyncML: Password not found.
Cause: A valid Everyplace password was not found.

User action: Verify that the information in your network profile is correct.
If you receive this error message after you have verified that the
information in in your network profile is correct, reinstall and reconfigure
Everyplace Client.

SyncML: Internet Access Point not found.

Cause: The Internet Access Point in your network profile has not been
configured correctly.

User action: Reconfigure the Internet Access Point in your Everyplace
Client network profile.

SyncML: Unsupported SyncML Software version on server.

Cause: The SyncML software version on your server is not supported.
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User action: Contact your organization’s technical support representative
to verify that they have installed the supported SyncML software version
on your server.

SyncML: Invalid user name or password.

Cause: The user name or password on your device does not match the
user name or password on the Everyplace Synchronization Server.

User action:Verify the user name and password on the Everyplace
Synchronization Server match the user name and password values in the
Everyplace Client network profile.

SyncML: Sync server was busy.
Cause: Everyplace Synchronization Server is busy.

User action: Try to synchronize again. If you continue to receive this error
message, contact your organization’s technical support representative.

SyncML: Server is not responding.
Cause: Everyplace Synchronization Server is busy.

User action: Try to synchronize again. If you continue to receive this error
message, contact your organization’s technical support representative.

SyncML: HTTP authentication failed.

Cause: The user name or password on your device does not match the
HTTP authentication user name or password on the Everyplace
Synchronization Server.

User action:Verify your HTTP authentication user name and password on
the Everyplace Synchronization Server match the user name and password
values in the Everyplace Client network profile.

Creating new contacts

When creating a new contact on the Nokia Communicator, there are several
generic fields that are not categorized. These include Telephone and Fax. If you
complete these fields without renaming them, they will synchronize to the server
as Other Telephone and Other Fax. To avoid this, press the button next to Rename
field while the cursor is on either the Telephone or Fax field and rename the fields.
Use the arrow keys to rename the Telephone field to either Telephone (Business) or
Telephone (Private). Also, use the arrow keys to rename the Fax field to either Fax
(Business) or Fax (Private). By renaming them, these fields will synchronize to the
server using the categorized field you select.

Managing time zones
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To avoid calendar events from synchronizing incorrectly, keep the time zone on
your device and the time zone in your synchronization profile on the server the
same.

Use the Change city feature on the communicator Clock to modify the time zone.
The value you specify for Current city indicates the time zone where the device
currently resides. The time of the event that is displayed in the calendar views is
based on this setting. For example, if the display is 8:00 and Current city is set to
Boston, MA, that means that the event is at 8:00 EST. This is the zone that you
should adjust when you move from time zone to time zone.
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Note: For more information about modifying the time zone setting on your device,
refer to the documentation that came with your device.

The time zone on your device must match the time zone specified in your
synchronization profile on the server. Whenever one of these is changed, you need
to change the other. If the Current city setting on the device and the
synchronization profile setting do not match, the times of some events might not
match. For more information on modifying your synchronization profile, refer to
(Creating a synchronization profile}

Working with calendar invitations

Everyplace Client does not support calendar invitations. If another user sends you
an invitation and you try to synchronize that invitation to your device, the
invitation will not be synchronized to your device as an invitation nor will the
invitation item be added to your calendar. The invitation will synchronize to your
device as an e-mail. If you want to add the invitation item to your device calendar,
you will need to add the invitation item to your device calendar manually.

Synchronizing

Everyplace Client to a SSL server using Mobility Client

If you use Mobility Client, set to use a GPRS Internet Access Point (IAP), to
synchronize Everyplace Client to a Secure Sockets Layer (SSL) server, you might
experience repeated synchronization failures due to a communication error. To
avoid repeated synchronization failures due to communication errors, you might
need to increase the keep alive setting in Mobility Client.
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Chapter 7. Uninstalling Everyplace Client

To uninstall Everyplace Client software from the Nokia Communicator:

1. Verify that Everyplace Client is not running on the device.

2. From your desktop, select Tools->Control panel->Data management-
>Application Manager.

3. Use the arrow keys to select IBM Everyplace Client on the Application
manager panel, and press the button next to Remove.

4. Press the button next to OK to confirm that you want to remove Everyplace
Client.

5. After your device has uninstalled Everyplace Client, press the button next to
OK to go back to the Application Manager.

Note: Follow these same instructions to remove all applications from your Nokia
Communicator. For more information about removing applications from your
Nokia Communicator, refer to the documentation that came with your device.
After you have removed an application, you must reboot the device by removing
the battery.

© Copyright IBM Corp. 2004 29



30 1BM: Everyplace Client



Appendix. Copyright and trademarks

rademark

Copyright

© Copyright IBM Corporation 1994, 2004. All rights reserved. U.S. Government
Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP
Schedule Contract with IBM Corp. IBM web site pages may contain other
proprietary notices and copyright information which should be observed.

Trademarks

Domino, Everyplace, IBM, Lotus, Passport Advantage, Sametime, and WebSphere
are registered trademarks of the IBM Corporation in the United States, other
countries, or both.

Microsoft is a trademark of Microsoft Corporation in the United States, other
countries, or both.

Other company, product, or service names may be trademarks or service marks of
others.
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